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Limitation of Warranty and Liability (effective June 2011) 

(For country-specific terms and conditions outside of the USA, please visit www.tsi.com.) 

Seller warrants the goods sold hereunder, under normal use and service as described in the operator's manual, 

shall be free from defects in workmanship and material for 24 months, or if less, the length of time specified in 
the operator's manual, from the date of shipment to the customer. This warranty period is inclusive of any 
statutory warranty. This limited warranty is subject to the following exclusions and exceptions: 

a. Hot-wire or hot-film sensors used with research anemometers, and certain other components when 
indicated in specifications, are warranted for 90 days from the date of shipment;  

b. Pumps are warranted for hours of operation as set forth in product or operator’s manuals; 

c. Parts repaired or replaced as a result of repair services are warranted to be free from defects in 
workmanship and material, under normal use, for 90 days from the date of shipment;  

d. Seller does not provide any warranty on finished goods manufactured by others or on any fuses, batteries or 
other consumable materials. Only the original manufacturer's warranty applies; 

e. Unless specifically authorized in a separate writing by Seller, Seller makes no warranty with respect to, and 
shall have no liability in connection with, goods which are incorporated into other products or equipment, or 
which are modified by any person other than Seller.  

The foregoing is IN LIEU OF all other warranties and is subject to the LIMITATIONS stated herein. NO OTHER 

EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR PARTICULAR PURPOSE OR MERCHANTABILITY 

IS MADE. WITH RESPECT TO SELLER’S BREACH OF THE IMPLIED WARRANTY AGAINST 

INFRINGEMENT, SAID WARRANTY IS LIMITED TO CLAIMS OF DIRECT INFRINGEMENT AND 

EXCLUDES CLAIMS OF CONTRIBUTORY OR INDUCED INFRINGEMENTS. BUYER’S EXCLUSIVE 

REMEDY SHALL BE THE RETURN OF THE PURCHASE PRICE DISCOUNTED FOR REASONABLE WEAR 

AND TEAR OR AT SELLER’S OPTION REPLACEMENT OF THE GOODS WITH NON-INFRINGING 

GOODS.  

TO THE EXTENT PERMITTED BY LAW, THE EXCLUSIVE REMEDY OF THE USER OR BUYER, AND THE 
LIMIT OF SELLER'S LIABILITY FOR ANY AND ALL LOSSES, INJURIES, OR DAMAGES CONCERNING THE 
GOODS (INCLUDING CLAIMS BASED ON CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY OR 
OTHERWISE) SHALL BE THE RETURN OF GOODS TO SELLER AND THE REFUND OF THE PURCHASE 
PRICE, OR, AT THE OPTION OF SELLER, THE REPAIR OR REPLACEMENT OF THE GOODS. IN THE 
CASE OF SOFTWARE, SELLER WILL REPAIR OR REPLACE DEFECTIVE SOFTWARE OR IF UNABLE TO 
DO SO, WILL REFUND THE PURCHASE PRICE OF THE SOFTWARE. IN NO EVENT SHALL SELLER BE 
LIABLE FOR LOST PROFITS OR ANY SPECIAL, CONSEQUENTIAL OR INCIDENTAL DAMAGES. SELLER 
SHALL NOT BE RESPONSIBLE FOR INSTALLATION, DISMANTLING OR REINSTALLATION COSTS OR 
CHARGES. No Action, regardless of form, may be brought against Seller more than 12 months after a cause of 
action has accrued. The goods returned under warranty to Seller's factory shall be at Buyer's risk of loss, and will 
be returned, if at all, at Seller's risk of loss. 

Buyer and all users are deemed to have accepted this LIMITATION OF WARRANTY AND LIABILITY, which 
contains the complete and exclusive limited warranty of Seller. This LIMITATION OF WARRANTY AND 
LIABILITY may not be amended, modified or its terms waived, except by writing signed by an Officer of Seller. 

Service Policy 

Knowing that inoperative or defective instruments are as detrimental to TSI as they are to our customers, our 
service policy is designed to give prompt attention to any problems. If any malfunction is discovered, please 
contact your nearest sales office or representative, or call TSI's Customer Service department at (800) 874-
2811 or (651) 490-2811. 

http://www.tsi.com/
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SOFTWARE LICENSE (effective March 1999) 

This is a legal agreement between you, the end user, and TSI Incorporated. BY INSTALLING THE 

SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO 
NOT AGREE TO THE TERMS OF THIS AGREEMENT, PROMPTLY RETURN THE UNOPENED 
PACKAGE AND THE ACCOMPANYING ITEMS (including written materials and binders or other containers) 
to TSI for a full refund. 
 

TSI SOFTWARE TERMS 

1. GRANT OF LICENSE. TSI grants to you the right to use one copy of the enclosed TSI software program 
(the “SOFTWARE”), on a single computer. You may not network the SOFTWARE or otherwise use it on 
more than one computer or computer terminal at the same time. 

2. COPYRIGHT. The SOFTWARE is owned by TSI and is protected by United States copyright laws and 
international treaty provisions. Therefore, you must treat the SOFTWARE like any other copyrighted material 
(e.g., a book or musical recording) except that you may either (a) make one copy of the SOFTWARE solely 
for backup or archival purposes, or (b) transfer the SOFTWARE to a single hard disk provided you keep the 
original solely for backup or archival purposes. 

3. OTHER RESTRICTIONS. You may not rent or lease the SOFTWARE, but you may transfer the 
SOFTWARE and accompanying written material on a permanent basis, provided you retain no copies and 
the recipient agrees to the terms of this Agreement. You may not reverse-engineer, decompile, or 
disassemble the SOFTWARE. 

4. DUAL MEDIA SOFTWARE. If the SOFTWARE package contains multiple types of media, then you may 
use only the media appropriate for your single-user computer. You may not use the other media on another 
computer or loan, rent, lease, or transfer them to another user except as part of the permanent transfer (as 
provided above) of all SOFTWARE and written material. 

5. U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE and documentation are provided with 
RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to the restrictions set 
forth in the “Rights in Technical Data and Computer Software” Clause at 252.227-7013 and the “Commercial 
Computer Software - Restricted Rights” clause at 52.227-19. 

6. LIMITED WARRANTY. TSI warrants that the SOFTWARE will perform substantially in accordance with 
the accompanying written materials for a period of ninety (90) days from the date of receipt. 

7. CUSTOMER REMEDIES. TSI’s entire liability and your exclusive remedy shall be, at TSI’s option, either 
(a) return of the price paid or (b) repair or replacement of the SOFTWARE that does not meet this Limited 
Warranty and which is returned to TSI with proof of payment. This Limited Warranty is void if failure of the 
SOFTWARE has resulted from accident, abuse, or misapplication. Any replacement SOFTWARE will be 
warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer. 

8. NO OTHER WARRANTIES. TSI disclaims all other warranties, either express or implied, including, but 
not limited to implied warranties of merchantability and fitness for a particular purpose, with regard to the 
SOFTWARE and the accompanying written materials. 

9. NO LIABILTY FOR CONSEQUENTIAL DAMAGES. In no event shall TSI be liable for any damages 
whatsoever (including, without limitation, special, incidental, consequential or indirect damages for personal 
injury, loss of business profits, business interruption, loss of information or any other pecuniary loss) arising 
out of the use of, or inability to use, this SOFTWARE. 

TRADEMARKS 

TSI and TSI logo are registered trademarks of TSI Incorporated. PresSura is a trademark of TSI 
Incorporated. Microsoft and Excel are registered trademarks of Microsoft Corporation.  
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Introduction 

The TSI PresSura Configuration software requires that a TSI USB key is attached to the system 
prior to running the application. The drivers for the TSI USB key are installed during the 
installation of the TSI PresSura Configuration Software. Attach the Key to the system. Start the 
TSI PresSura Configuration software application by double-clicking on the desktop shortcut or 

through the system program menu TSI | TSI PresSura Configuration software shortcut.  

When accessing the instrument via the software, the TSI PresSura Room Controller or PresSura 
Room Monitor must have the main running screen active. If the instrument is displaying a menu 
selection or a menu function screen, the software will be unable to communicate with the 
instrument. 

The application starts with a blank configuration screen.  

 

Figure 1. Configuration Screen 



2 PresSura Configuration Software 

The TSI PresSura Configuration Software functionality is available through the application menu 
as well as toolbar buttons.  

Use the application tool bar to read 
configuration data, update configuration data, 
open a saved configuration file and save the 
current configuration to a file. 

 

Figure 2. Application Tool Bar 

Use the File menu to open a saved configuration file, save the 
current configuration to a file and exit the application. 

 

Figure 3. File Menu 

Use the Instrument menu to read the configuration from the 
attached device. Also update the selected configuration values 
to an attached device. 

 

Figure 4. Instrument Menu 

Use the Help menu to view this user manual for this software, 
as well as the version and contact information about this 
software. 

 

Figure 5. Help Menu 

The status and progress bar at the lower portion of the active screen provides information about 
the task that is being performed by the Room configuration software.  

The status at application start should reflect the following image.  

 

Figure 6. Status Message before Reading or Writing Configuration Data 

The status at the completion of a read of the attached instrument should reflect the following 
image. 

 

Figure 7. Status Message after Reading Configuration Data 
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Reading Configuration from an Attached Instrument 

To read the configuration from an attached instrument, click the READ button  or 

select Read from the Instrument menu.  

The software will automatically search the available Com Ports to find an attached TSI Room 
Controller or TSI Room Monitor instrument. Make sure that the attached instrument is powered 
with the main run screen active.  

The software will read the configuration, set points, interface, and control settings from the 
instrument. Then the software will populate the tabs of the PresSura Configuration Software 
dialog. When reading the instrument configuration has completed, the status bar will show 

COMPLETE and the progress bar will be filled and disappear.  

The following screens are the tabs of the Room configuration software dialog. 

Configure 

 

Figure 8. Configure Screen 



4 PresSura Configuration Software 

Note: The Number of Rooms setting will hide or show menus: 

Number of Rooms Setting 
Room 1 
Alarms 

Anteroom 
Alarms 

Room 2 
Alarms 

1 Room    

1 Room with Anteroom    

2 Rooms with Anteroom    

Table 1. Menu Availability based on Number of Rooms Setting. 

Alarm Config 

 

Figure 9. Alarm Config Screen 
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Room 1 Alarms 

 

Figure 10. Room 1 Alarms Screen 

Room 2 Alarms 

 

Figure 11. Room 2 Alarms Screen 

Note: The Room 2 Alarms menu will only appear if the Number of Rooms item on the Configure 
menu is set to “2 Rooms with Anteroom”. 



6 PresSura Configuration Software 

Anteroom Alarms 

 

Figure 12. Anteroom Alarms Screen 

Note: The Anteroom Alarms menu will only appear if the Number of Rooms item on the 
Configure menu is set to “1 Room with Anteroom” or “2 Rooms with Anteroom”. 

 

 

 

(continued on next page) 
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Room 1 Setpoints 

 

Figure 13. Room 1 Setpoints Screen 

Note: The Room 1 Setpoints menu will appear for Model RPM10 and RPM20 monitors but will 
not affect the instrument’s function. 

Interface 

 

Figure 14. Interface Screen 
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Control 

 

Figure 15. Control Screen 

Note: The Control menu will appear for Model RPM10 and RPM20 monitors but will not affect 
the instrument’s function. 
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Sensors 

 

Figure 16. Sensors Screen 

Note: Each Input of the Sensors item will populate based on the corresponding Input 
configurations on the Configure menu. 

Modifying Configuration Settings of an Attached TSI Room 

Controller or TSI Room Monitor Instrument 

To modify the configuration of an attached instrument click the update button  or 

select update from the Instrument menu. Make sure that the attached instrument is powered with 
the main run screen active.  

The software will automatically search the available Com Ports to find an attached TSI Room 
Controller or TSI Room Monitor instrument.  

The software will update the current selected configuration, set points, interface, and control 
values from the software tabs to the instrument. The software will write the configuration settings 
one by one to the instrument until all settings have been updated or an error condition has arisen. 
Upon  a successful completion of writing all of the configuration, set point, interface and control 
values to the instrument, the software will then read the configuration, set points, interface, and 
control settings of the instrument and re-populate the tabs of the Room configuration software 

dialog. The status bar will show COMPLETE and the progress bar will be filled and disappear 
upon completion of the update process.  

Refer to the Operation and Service Manual for the Model RPM10 and RPM20 monitors or RPC30 
controller for complete descriptions of the menu items. 
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Saving a Configuration File 

To save a selected configuration or a configuration from an attached instrument click the Save 

To File button  or select Save from the File menu.  

A save as dialog will ask the user to browse to the save location and enter a file name to save the 
file as. The file can be saved to any location that has access to write a file and to any name. The 
user will need to manage the locations and names of the files created by the TSI Room 
configuration software.  

 

Figure 17. Save Configuration File Dialog Box 

Enter the file name to save the file as and select the Save Button. If no error messages appear, 
the file has been saved to the selected location.  

Loading a Saved Configuration File 

To Load a saved configuration from a saved configuration file, click the Open File button 

 or select Open from the File menu.  

An open file dialog will ask the user to browse to the location and select a valid Room 
configuration file to open.  
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Figure 18. Open Configuration File Dialog Box 

Select the Open button, if no error messages appear, the configuration from the file has been 

loaded to the Room configuration software. Select the Update button to write the loaded 
configuration to an attached instrument.  

Note 

A set of configuration files that correspond to selections of the Config Wizard of the instrument 
are provided. These are stored in the Configuration Files directory of the installed location. The 
file names of these files include the number selection and a description that corresponds to the 
Config Wizard selections.  
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Report Generator 

Access the report generator by either double clicking the TSI Room Report Generator desktop 

icon or the system program menu TSI | TSI Room Report Generator shortcut.  

The report generator runs with Microsoft
®
 Excel

®
 spreadsheet software. Excel

®
 macros must be 

enabled for the report generator to function properly.  

  

Figure 19. Room Report Generator Screen 

The initial screen of the Report Generator includes two buttons.  

The Generate Report button generates an editable report of the configuration settings file that is 
supplied.  

The About button shows information about the report generator macro.  

Generating a Report from a Saved Configuration File 

To Create a Report of a TSI Room controller or monitor instrument configuration:  

1. Through the PresSura Configuration Software application, read the configuration of the 
Instrument. Next, save the configuration of the instrument to a file following the steps in the 
“Saving a Configuration File” section from above.   

2. Open the TSI Report Generator.  

3. Select the Generate Report button. An Open File dialog box is displayed. Browse to the 
location of the saved configuration file.  

4. Select the configuration file that was previously saved and contains the configuration that is 
to be reported.  
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Figure 20. Opening a Configuration File with the Report Generator 

5. Select the Open button. This will load the configuration values into the report.  

6. Next a Save Report dialog box is displayed. Browse to the location that you want to save the 
report file and enter a file name of the report file.  

 

Figure 21. Saving a Configuration File with the Report Generator 
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7. Select the Save button to save the generated 
report file. 

8. The done message is displayed when the report 
file has been generated and saved (Figure 22). 

Select the OK button. 

9. The report is ready to be completed with the 
specific customer information and notes from 
the installation. Enter the customer and Room 
location specifics in the fields provided and add 
the notes from the installation. Then save the 
report file (Figure 23). 

 

Figure 22. Done Message 

 

Figure 23. Room Configuration Report 
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10. The Report may easily be converted to a PDF file through the File tab within Excel
®
 software.  

  

Figure 24. Creating PDF through Microsoft Excel Software 



16 PresSura Configuration Software 

Error Messages 

USB Key Error 

The following message 
(Figure 25) is displayed if the 
application is started without 
that TSI USB Key attached. 

 

Figure 25. Error Message if Application is Started 
without USB Key  

Connection Error 

The following message 
(Figure 26) is displayed if the 
application cannot find an 
attached Room instrument. 

 

Figure 26. Error Message if PresSura Room Monitor or 
Controller is not found 

Check the following: 

 The Instrument is attached to the system. 

 The FTDI drivers are installed.  

 The instrument is powered  

 The main run screen is the active screen of the instrument.  
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Alarm Setting Errors 

While updating the configuration settings to the instrument, a message similar to the following 
message may be displayed if an updated setting is in conflict with another setting. For example, if 
the Negative Low Alarm is set too close to the Negative Setpoint, the alarm message will be 
displayed as:  

 

Figure 27. Setpoint Conflict Error Message 

Check the configuration values of the set point and alarm values that are referred to in the 
messages. The alarm values must be within a range based on the value of the set point.  

To check the current alarm values click the READ button. Switch to the appropriate setpoints or 
alarm tab, and check the values that are displayed in the set point and alarm values. Correct 

these values as necessary, then click the UPDATE button. 
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